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Introduccion

iBienvenidos a Rebelle 2!

Rebelle es una aplicacion de pintura Unica que le permite crear obras de arte realistas de las
medios hiumedos y secos, con simulacion impresionante y dinamica de flujo de fluidos, de la
mezcla de color, difusion hiumeda y del secado. Rebelle imita convincentemente la forma en
gue los medios naturales interactian con el lienzo y con él mismo. Los usuarios pueden
pintar, manchar, mojar los colores secos, soplar pintura humeda sobre el lienzo, inclinar el
papel para crear gotas de agua y crear incontables efectos fantasticos de acuarela.

Hemos disefiado Rebelle para los artistas CG asi como para los pintores tradicionales que
quieren explorar y ampliar su repertorio artistico, utilizando la ultima tecnologia digital
innovadora de la pintura.

Rebelle 2 integra muchas mejoras, pinceles de acuarela y acrilico obtuvo una mirada realista
sin precedentes y junto con fluido enmascarador dan un toque tradicional excepcional a la
pintura digital. Completamente nuevo motor de los pinceles permite a los usuarios crear
pinceles personalizados - redondo, plano, bambu, varias salpicaduras hiumedas, esponjas y
muchos otros.

Nuevos esténciles y herramientas de seleccidn junto con la difusidn de pintura humeda
abren nuevos resultados creativos todavia no posibles de lograr en el arte digital. Esta nueva
versién viene con soporte completo multi-touch y soporte de PSD. Todas estas
caracteristicas practicas se envuelven en una interfaz agradable y facil de usar con una
pequeiia curva de aprendizaje.

En este manual encontrara informacién general sobre todos los detalles que necesita saber
para un uso de este software. Hemos preparado las explicaciones de sus caracteristicas,
indicios utiles y antecedentes técnicos de Rebelle para ustedes.

iGracias por comprar Rebelle, espero que pase gran tiempo con la pintura!

Peter Blaskovi¢
Creador de Rebelle
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Empezamos

Instalar y Registrar Rebelle

Descargar & Instalar

Después de comprar Rebelle desde nuestro sitio web, recibird el correo electrénico con un
enlace para descargar y con detalles para registrar.

Usuarios de Mac OS X
Descarga un archivo .dmg del enlace que aparece en un correo electrénico. Localice el

archivo de instalacion de Rebelle llamado "Rebelle 2.dmg". Haga doble clic en el archivo de
instalacidon para completar la instalacion.

Usuarios de Windows

Descarga un archivo .exe para el sistema 32 o 64-bit del enlace que aparece en un correo
electrénico. Localice el archivo de instalacion de Rebelle llamado "Rebelle 2.exe". Haga doble
clic en el archivo de instalacidn .exe para completar la instalacion.

Registrar

Introduzca sus datos para registrar desde el correo electrénico. Por favor compruebe si estd
conectado a Internet se requiere la conexién a Internet para la activacion para comprobar
los datos de registro.

SUGERENCIA: Le recomendamos copiar & pegar su Clave de Registro e ID para evitar la falta
de ortografia.

Iniciar la Aplicacion

Vera un “Intro Tutorial” durante el primer inicio de la aplicacién o después de cada
actualizacion a la versidon mas reciente. Este tutorial le guiard a través de las herramientas
mas esenciales de Rebelle. Puede abrir este “Intro Tutorial” desde Menu -> Ayuda (Menu ->
Help) en cualquier momento.

Requisitos del Sistema
Minimos: Intel i3 o equivalente AMD procesador, 4GB de RAM, espacio de disco duro de

100MB, tarjeta grafica Open GL con 1GB RAM, Windows Vista (64-bit o 32-bit) o Mac OS X
10.9.



Recomendados: Intel i7 o equivalente AMD procesador, 16GB de RAM, espacio de disco
duro de 100MB, tarjeta grafica Open GL con 4GB RAM, Windows 7, 8 o Mac OS X 10.10
0 mas nuevo, tableta grafica compatible con Wacom o Surface.

Soporte de Tableta
Cuando Rebelle se inicie por primera vez se le pedird que seleccione el dispositivo de tableta
preferido: compatible con Wacom o compatible con Microsoft Ink. Puede cambiar las

opciones de tableta en cualquier momento en Preferencias -> Tablet.

Idiomas

Rebelle estd disponible en diferentes idiomas. Puede seleccionar el idioma de la interfaz de
Rebelle a través del menu Ayuda -> Idioma (Help -> Language). Tiene que reiniciar Rebelle
para aplicar estos cambios.

Obtener Soporte para Rebelle

Si necesita ayuda para utilizar Rebelle en primer lugar consulte este manual incluido. Hemos
intentado hacerlo facil para leer y lleno de informacién que necesita saber.

Le invitamos a enviarnos un correo electronico a support@escapemotions.com si usted tiene

cualquier pregunta, problema técnico con Rebelle o le gustaria simplemente para
saludarnos.

Antes de hacer preguntas por favor lea la FAQ en ‘support’ seccidn en el sitio web
rebelle.escapemotions.com en primer lugar. Si la respuesta no esta ahi por favor agrega la
configuracion de su equipo a su correo electronico (Windows / Mac OS, 32 / 64 bits del
sistema operativo, procesador, tarjeta grafica, memoria). Esto nos ayudard a proporcionar
respuestas mucho mas rapido.

Comunidad
Sigamos en contacto en nuestros canales sociales - haga clic en cualquier icono y visitar

nuestras paginas en Facebook, Twitter, Pinterest, Google+, Tumblr, YouTube, DeviantArt y
Behance.

fIv]P|S]tPi)%]se
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Interfaz de Rebelle

1 — Barra de Menu (Menu Bar)

2 — Panel de Herramientas (Tools Panel)

3 — Panel de Propiedades (Properties Panel)
4 — Panel de Navegador (Navigator Panel)

5 — Panel de Color (Color Panel)

6 — Panel de Conjunto de Colores (Color Set Panel)

7 —Panel de Capas (Layers Panel)

8 — Panel de Creador de Pinceles (Brush Creator Panel)
9 — Panel de Inclinacién (Tilt Panel)

10 — Panel de Esténciles (Stencils Panel)

SUGERENCIA: Todos los paneles son acoplables - es posible modificar, cambiar la posicion y
ajustar la anchura de los paneles. Los paneles ocultan mientras que se pinta en el lienzo
detrds de ellos.



Puede cambiar la interfaz de Rebelle de acuerdo a sus necesidades. Abajo estdn los ejemplos

de diseno de interfaz de usuario:

1. Interfaz predeterminada con el 2. Panel de Herramientas y Propiedades en
Panel de Inclinacién no acoplado. modo vertical en el lado izquierdo, los otros
paneles son fusionados en el lado derecho.

4. Paneles de Herramientas, Propiedades y
Conjunto de Colores en modo vertical son
fusionados en el lado izquierdo con el Panel de
Color no acoplado.

3. Paneles de Herramientas y Propiedades en
modo horizontal en la parte superior, los otros
paneles son fusionados en el lado izquierdo.



Panel de Herramientas

- Pinceles: Acuarela, Acrilico, Pastel, Lapiz, Pluma,
Rotulador y Aerégrafo.

- Borrador

- Herramientas: Fusionar, Manchar, Mojar, Secar,
Soplar, Escoger Color, Transformar y Seleccién.

- Deshacer / Rehacer

~ Contraer Panel - Contraiga el Panel de Herramientas. Este botdn estd presente en todos
los paneles de la interfaz de Rebelle.

— Menu de Panel de Herramientas: Seleccione para cerrar el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window menu).

La siguiente imagen muestra el comportamiento de cada técnica de pintura:

Watercolor Acrylic Pastel

Pencil Ink Pen Marker Airbrush

/ Fusionar - Herramienta para fusionar los colores o marcas de pincel.
» Manchar - Herramienta para manchar los colores o marcas de pincel.

0 Mojar - Seleccione la herramienta de mojar para afiadir agua a una parte especifica del
lienzo.



Secar - Seleccione la herramienta de secar para eliminar agua de una parte especifica del
lienzo.
= Soplar - Seleccione la herramienta para soplar los colores hiumedos.
4
7 Escoger Color - Seleccione la herramienta para escoger el color del lienzo.
X Transformar - Mueve, escale, rote o voltee la capa seleccionada.

... Seleccidn - Seleccione y marque areas del lienzo para realizar operaciones en esta area

seleccionada.

©D Deshacer - Deshace la tltima operacion de pintura que ha realizada.

C Rehacer - Rehace la Gltima operacion de deshacer.
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Panel de Propiedades

Este panel contiene ajustes de herramientas y pinceles preestablecidos.

Todos los pinceles, borrador, asi como herramienta Fusionar, Manchar, Mojar y Secar tienen
varios pinceles preestablecidos disponibles. Puede crear sus propios pinceles usando el
panel Creador de Pinceles (Brush Creator). Muestre u oculte el panel Creador de Pinceles

utilizando el botdén == en la esquina inferior izquierda del panel Propiedades.

Haga clic en el botdén @ para duplicar el pincel preestablecido seleccionado o el botén B
para eliminar el pincel preestablecido seleccionado.

Puede cambiar el orden de los pinceles mediante arrastrar y soltar o cambiar el nombre del
pincel seleccionado haciendo doble clic en él, escribiendo un nuevo nombre y pulsando
Enter.

Mas informacién acerca de como crear pinceles personalizados se puede encontrar en la
seccion Panel de Creador de Pinceles.

o4 Pincel Borrador - Utilice cada pencil como un borrador.

= Men de Panel de Propiedades - Restablezca a los valores predeterminados, Importe y
Exporte Pincel Preestablecido del archivo de imagen o Cierre el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window Menu).

Propiedades de Herramienta Acuarela

Size 70 Los pardmetros son predeterminados para simular el
Pressure comportamiento de los acuarelas. Para efectos
Loading 60 diferentes, los parametros se pueden ajustar de
wWaker 3 acuerdo a sus necesidades:

.I- p_i ﬁvl- D-I-

Tamaiio - Ajuste el tamaiio del pincel (1-100).

e Presion - Ajuste la presidon del pincel (1-100). Si se utiliza
e - ¥ la presidn del [apiz de la tableta grafica, puede ajustar la
sensibilidad a la presion.
Cargando - Ajuste la cantidad de color cargado al pincel
(1-100). - Influya el espesor del pincel.
Agua - Ajuste la cantidad de agua (1-100). Cuanta mas
agua estd aplicada en el pincel, mas realista esta el
efecto de la acuarela que se puede conseguir.
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SUGERENCIA 1: Puede cambiar el tamario del pincel directamente en el lienzo utilizando el
atajo Ctrl o Cmd + clic con boton izquierdo del raton y arrastrar. Arrastre hacia la izquierda
para disminuir el tamano del pincel, a la derecha para aumentar el tamano del pincel.

SUGERENCIA 2: Puede establecer una sensibilidad de presion de pluma mds suave o mds
firme en Preferencias -> Tableta (Preferences -> Tablet). Puede cambiar la presion
individualmente para cada herramienta en su panel de Propiedades con el deslizador de
Presion.

SUGERENCIA 3: Ajuste "Agua" a 1 para humedecer la capa ligeramente, o ajuste "Agua” a
valores superiores para poner mds agua a la parte especifica del lienzo. No es necesario
utilizar mucha agua para obtener efectos bonitos de acuarela.

& . . . . .
# Pincel Permanente (Permanent Brush) - Cuando estd activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel.

3
£ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando".

£ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el ultimo color cargado en la misma.

O Pincel Limpio (Clean Brush) - El pincel limpio no esta cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo.

12



Propiedades de Herramienta Acrilico

Color de acrilico es el medio humedo utilizado en su
mayoria con pinceles planos. Puede ajustar los
parametros de color de acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del pincel (1-100).

Presion - Ajuste la presién del pincel (1-100) — Influya el
espesor del pincel.

Cargando - Ajuste la cantidad de color cargado al pincel
(1-100).

Agua - Ajuste la cantidad de agua en color (1-100).

SUGERENCIA: Ajuste "Cargando" al valor mds bajo y
obtendrd un pincel fino. Establezca los valores mds altos
y obtendrd el pincel espeso con una gran cantidad de

masa.

& . . . . .
# Pincel Permanente (Permanent Brush) - Cuando esta activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel:

Cargando al ‘1’ Cargando al ‘25’ Cargando al '50’ Cargando al ‘100’

3
£ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando":

Cargando al ‘1’ Cargando al 25’ Cargando al ’50’ Cargando al ‘100’
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£ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el ultimo color cargado en la misma:

1. trazo: el pincel pasa de color naranja a azul.
2. trazo: el pincel queda coloreado por el dltimo color
cargado en la misma (en nuestro caso es color azul).

O Pincel Limpio (Clean Brush) - El pincel limpio no esta cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo:

1. trazo: el pincel pasa de color naranja a azul. Cuando se
suelta, el pincel se limpia.

2. trazo: el pincel limpia pinta de nuevo desde el naranja al
color azul.

SUGERENCIA: Se puede ajustar los atajos del teclado personalisados para Pincel Permanente,
Normal, Sucio y Limpio en panel de Preferencias. Cuando se ajustan atajos en seccion
Herramientas (Tools), el atajo activard el pincel particular. Cuando se ajustan los atajos en
seccion Herramientas - mantener (Tools - hold) el pincel se activard sélo cuando el atajo estd
mantenido.

14



Establezca la visibilidad de la estructura con el control deslizante Estructura de Pintura (0-
100) en la ventana Seleccionar lienzo (en el panel de Capas). Vea el siguiente ejemplo:

Paint Structure

-

50 100

Propiedades de Herramienta Pastel

Pastel es un medio seco en la forma de un palo, que
consiste en pigmento en polvo puro y un aglutinante.
Puede ajustar los pardmetros de acuerdo a sus
necesidades:

Tamaiio - Ajuste el tamafio del pastel (1-100).
Presion - Ajuste la presidn del pastel (1-100) — Influya el
espesor del pastel.

15



Propiedades de Herramienta Lapiz

Lapiz de color es un medio artistico construida de un
nucleo estrecho y pigmentada encerrado en una caja
cilindrica de madera. Puede ajustar los pardmetros de
acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del lapiz (1-100).
Presion - Ajuste la presion del lapiz (1-100) — Influya el
espesor del lapiz.

Propiedades de Herramienta Pluma

La tinta es un liquido que contiene pigmentos o
colorantes. Puede ajustar los pardmetros de acuerdo a
sus necesidades:

Tamaiio - Ajuste el tamafio de la pluma (1-100).

Presion - Ajuste el espesor de la pluma (1-100).
Agua - Ajuste la cantidad de agua en color (1-100).

16



Propiedades de Herramienta Rotulador

Rotulador es una pluma que tiene su propia fuente de
tinta y generalmente una punta hecha de fibras porosas
y presionadas tales como fieltro. Puede ajustar los
parametros de acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del rotulador (1-100).
Presion - Ajuste el espesor del rotulador (1-100).

Propiedades de Herramienta Aerdgrafo

Aerdégrafo es una herramienta pequefia, operada por
aire que rocia diversos medios incluyendo la tinta y el
tinte. Puede ajustar los pardmetros de acuerdo a sus

necesidades:

Tamaio - Ajuste el tamario del aerdégrafo (1-100).
Presion - Ajuste la presién del aerdégrafo (1-100) —
Influya la densidad del aerdgrafo.

17



Propiedades de Herramienta Borrador

Tamaiio - Ajuste el tamafio del borrador (1-100).

Presidn - Ajuste la presién del borrador (1-100).

[] Keep Layer Wet

Mantener Capa Himeda - Active esta opcidn si desea

. . que el borrador mantiene el drea borrada himeda para
pintura posterior. El borrador seque completamente el

‘:f't" -\:t" area borrada por defecto.

Round Squars

"o,

—
——
—

SUGERENCIA: Puede ajustar la punta del borrador de un Ildpiz de tableta grdfica a borrador
en Rebelle via “Preferencias -> Herramientas (mantener)” / “Preferences -> Tools (hold)”.
Seleccione “Borrador” y lo ajuste al “Ldpiz (Borrador)” en la parte inferior de la ventana.

Propiedades de Herramienta Fusionar

Esta herramienta fusione los colores y pinceladas.

oize Tamaiio — Ajuste el tamafio de la herramienta Fusionar
Pressure 50 (1-100).
Presion - Ajuste la presién de la herramienta Fusionar
(1-100).

N~ SUGERENCIA: Puede fusionar colores con el toque de un
dedo en las tabletas con pantallas tdctiles. Puede

Soft

cambiar esto en cualquier momento en el panel de
Preferencias.
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Pressure

[] smudge Only Wek

Propiedades de Herramienta Manchar
Esta herramienta mancha las partes humedas y secas de
la pintura.

Tamaio - Ajuste el tamafio de la herramienta Manchar
(1-100).

Presidn - Ajuste la presién de la herramienta Manchar
(1-100).

Manchar Sélo Himedo - Active esta opcion si desea
manchar sélo partes hiumedas de la pintura. Cuando se
desactiva, esta herramienta mancha partes hiumedas y

secas de la pintura:
Manchar Sélo Humedo Manchar Todo - humedo y seco

Propiedades de Herramienta Mojar

Tamaiio - Ajuste el tamafio de la herramienta Mojar (1-
100).

Agua - Seleccione una cantidad de agua.

Cuanta mas agua se selecciona, el mas humedo el lienzo

se pone.
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Propiedades de Herramienda Secar

Size

Tamaiio - Ajuste el tamafio de la herramienta Secar (1-
Absorben 26 100).

L] Keep Layer wet Absorbencia - Seleccione un poder de absorcién del
lienzo. Cuanto mayor es el nUmero seleccionado, el mas
rapido la agua se absorbe.

Mantener Capa Himeda - Active esta opcidn si desea
gue la herramienta Secar mantiene el area secada
himeda para pintura posterior. La herramienta Secar
seque completamente el drea por defecto.

SUGERENCIA: Desde Rebelle 2 Herramientas Mojar y Secar también tienen pinceles para
elegir - ahora puede crear varias salpicaduras humedas agradables y otros efectos humedos.

NOTA: Las Herramientas Mojar y Secar automdticamente activan modo de ‘Mostrar
Humedo’. Puede cambiarlo a través Menu: Archivo -> Preferencias -> Herramientas (File ->
Preferences -> Tools) donde desactive la opcion ‘Mostrar capa humeda cuando se ulitiza la
herramienta Mojar o Secar’.

Propiedades de Herramienta Soplar

Esta herramienta sopla un color que es himedo en la
direccion de su movimiento.

Tamaiio - Ajuste el tamafio de la herramienta Soplar (1-
100).
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Sample Size;

New color

Color sample

Original color

"."".'-i d C |-|

Height 900

Angle 0.00°

<A

Propiedades de Herramienta Escoger Color

Esta herramienta le permite escoger color de la capay
del lienzo y mezclarla con otro color.

.-f Mezclar Colores - Presione el botén "Mezclar
Colores" o mantenga la tecla "X" para mezclar el color
escogido con el color anterior.

Muestra:

~ Capa Actual - El color se escogid sélo de una capa
activa.

= Todas Capas - El color se escogié de todas las capas
excepto un color del lienzo de fondo.

— Todas Capas y Lienzo - El color se escogi6 de todas
las capas que incluyendo el lienzo de fondo.

Tamaio de Muestra - El tamano promedio de la
muestra.

Cuando la herramienta Escoger Color se selecciona el
cursor cambia a un circulo con tres zonas de colores
diferentes:

Color Original - El color seleccionado.

Muestra de Color (Sample) - El color del lienzo debajo
del disco.

Color Nuevo (New Color) - El color seleccionado nuevo.

Propiedades de Herramienta Transformar
Transforme la capa actual y su posicion.

X - Ajuste la posicion X de la capa.

Y - Ajuste la posicion Y de la capa.

Cuando ambas posiciones se establecen a 0, la capa se
transforma al lado izquierdo y superior del lienzo.
Anchura - Ajuste la anchura de la capa.

Altura - Ajuste la altura de la capa.
Angulo - Ajuste el angulo de la rotacién.
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- . .
=3 Voltear Verticalmente - Voltee la capa verticalmente.

A Voltear Horizontalmente - Voltee la capa horizontalmente.

La siguiente imagen muestra cémo utilizar la Herramienta Transformar con el ratdn, stylus
de la tableta y el toque:

Scale
S § 7
< Move & Rotate
= = = %
Use two fingers o 3 e Use mouse, finger or pen

to transform layer. to transform layer.

Mover - Mueve una capa transformada.

Escalar - Escale para aumentar o reducir una capa transformada en relacion a su esquina
superior izquierda. Puede escalar una capa horizontalmente, verticalmente o ambos. Utilice
teclado Shift para escalar proporcionalmente. Utilice teclado Alt para escalar una capa con
respecto a su centro.

Rotar - Herramienta rote una capa transformada alrededor de su centro. Utilice teclado Shift
para bloquear la rotacién en angulos de 45 grados.

Mueve, escape y rote con ratdn, stylus o con el toque. Utilice dos dedos para mover, rotary
escalar la capa simultaneamente. Mas informacidn sobre el soporte tactil en Rebelle se
puede encontrar en la seccién Soporte Multitactil (Multi-touch Support).

Propiedades de Seleccion

Seleccione un area especifica del lienzo y realice
operaciones en este area seleccionada.

Hay cuatro tipos de herramienta Seleccidn disponibles:

r=="

i..: Rectangulo - Cree selecciones rectangulares haciendo clic y arrastrando sobre el lienzo.

*.." Elipse - Cree selecciones elipticas haciendo clic y arrastrando sobre el lienzo.
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Utilice el atajo Shift para escalar la seleccion rectangular o eliptica proporcionalmente.
Utilice el atajo Alt para escalar la seleccidn en relacion a su centro.

Utilice el atajo Shift para habilitar la rotacién en angulos de 15 grados. Puede cambiar el
angulo predeterminado en el panel Preferencias -> Herramientas en "Transformacién".

o Poligono - Cree selecciones poligonales. Haga clic para colocar un punto de seleccién,
suelte el botdn del ratdn y haga clic para colocar el punto siguiente. Para terminar creacion
de la seleccién poligonal haga clic en el primer punto de nuevo o presione Enter - el ultimo
punto se vinculard automaticamente al primer punto.

.-’ A Mano Alzada - Cree selecciones a mano alzada dibujando un contorno alrededor del
area que desea seleccionar. Cuando se suelta el ratén el final de la linea se conectard
automadticamente a su inicio.

Nota: Confirme la seleccion rectangular, eliptica y poligonal pulsando Enter o haciendo clic en
la ventana grdfica fuera de la drea seleccionada.

Hay tres modos de como una nueva seleccién se afiade a cualquier seleccion actual en el
lienzo:

] Seleccion Nueva - Sustituya la seleccién actual por la nueva seleccion.

‘ Aiadir a Seleccion - Alada una nueva seleccion a la seleccién actual para crear un nuevo
resultado. (Atajo: Shift)

ﬁ Restar de la Seleccidn - Reste el drea de la nueva seleccidn de la seleccién actual para
crear un nuevo resultado. (Atajo: Alt)

l] Invertir Seleccion - Invierta la seleccion actual. (Shortcut Ctrl + Shift + 1/ Cmd + Shift + 1)

Nota: Seleccione el contenido de la capa actual utilizando Ctrl / Cmd + A o a través del menu
Editar -> Seleccionar Todo. Anule la seleccion actual pulsando Ctrl / Cmd + D o a través del
menu Editar -> Deseleccionar Todo.

Puede encontrar mas informacion sobre cdmo usar las selecciones en Rebelle en la seccion
Trabajar con Selecciones.
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shape

Opaciky

Opacity Jitter

Size Jitker

Angle Jicker

[1 Follow Stroke

Texkture

ion

Panel de Creador de Pinceles

Grain

[ smudge

[ random Start

[ random Splat

Puede create sus pinceles personalizados en
el panel Creador de Pinceles. Abra el panel

con el boton == en el panel Propiedades o a
travéz el menu Ventana.

Nombre de Pincel - El nombre del pincel se
muestra en la parte superior. Puede cambiar
el nombre del pincel haciendo doble clic en él
en la lista de pinceles (en el panel
Propiedades).

Vista Previa de Pincelada - La vista previa de
pincelada se coloca debajo del nombre del
pincel y muestra como se vera la pincelada
con la configuracién actual del pincel (Tenga
en cuenta que no todos los pardmetros se
muestran en la vista previa del pincel).

Forma de Pincel - Elija la forma de su pincel
personalizado. Haga clic en la miniatura de

forma (shape) y elija de una lista de formas
preestablecidas.

Grano de Pincel - Elija el grano de su pincel.
Haga clic en la miniatura de grano (grano) y
elija de una lista de granos preestablecidos.

NOTA: Las formas y granos son accesibles a
través del menu: "Ayuda" -> "Mostrar carpeta
de Biblioteca" ("Help" -> "Show Library
folder") donde puede pegar cualquier forma o
grano a su respectiva carpeta en formato
PNG, JPG o BMP.
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Parametros de presion

Establezca cémo el tamafio y la opacidad del pincel deben estar influenciados por la presion
del lapiz de la tableta (-100 - 100). Los valores negativos invertirdn los resultados de la
presion:

Tamafio 100

k.
S

Opacidad 100 Opacidad -100

Parametros de forma

Establezca varias opciones para la forma del pincel personalizado:

Espaciado - Controle la distancia entre las marcas del pincel (1-100). Cada marca del pincel
estd separada a lo largo de la carrera por un valor establecido, el valor 100 es igual al
tamafio completo real de la marca del pincel:

Espaciado 1 Espaciado 50 Espaciado 100

Variacidon de Espaciado - Espaciado aleatorio (0-100):

gk
Vol ﬂ'*‘*t

Dispersion - La dispersion del pincel aleatoriza la colocacidn de las marcas del pincel en una
pincelada hacia arriba o hacia abajo con respecto a la linea de base de la pincelada (0-100):
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Opacidad - Establezca la opacidad del pincel personalizado (1-100). Las partes superpuestas
de las marcas del pincel aumentaran la opacidad adicional:

Variacion de Opacidad - Especifique cdmo la opacidad de la pintura varia en una pincelada,

hasta (pero no excediendo) el valor de opacidad especificado en el deslizador Opacidad (0-
100):

L 2.0
R

Variacion de Tamaifio - Especifique cémo el tamafio de las marcas del pincel varia en una

pincelada hasta (pero no excediendo) el valor de tamaiio especificado en el panel
Propiedades (0-100):

Variacion de Angulo - Cada marca del pincel en la pincelada se rota aleatoriamente de
acuerdo con el dngulo actual (0-100):

Seguir Trazo - Seleccione si el pincel debe seguir la rotacién del trazo o no.
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Manchar - Seleccione si la marca del pincel del medio humedo (acuarela, acrilicos, pluma)
debe estar manchada o no. Cuando ‘Manchar’ estd activo, las marcas del pincel se manchan
juntas para reducir la apariencia de marcas individuales.

Parametros de grano

Establezca varias opciones para el grano del pincel personalizado:

Escalar - Establezca la escala del grano (100-800). Escriba un nimero o utilice el control
deslizante para introducir un valor que sea un porcentaje del tamafio del grano.

Seguir Tamaiio de Forma - Seleccione si el grano debe seguir el tamano de la forma o no.
Cuando esta activo el grano coincide con el tamafio de la forma del pincel.

Seguir Rotacién de Forma - Seleccione si el grano debe seguir la rotacién de la forma o no.
Cuando esta activo el grano rota con la forma dentro de la marca del pincel.

Empiezo Aleatorio - Aleatorize la posicion del grano con respecto a la marca del pincel para
cada trazo de modo que los trazos no son idénticos.

Salpicadura Aleatoria - Aleatorize la posicidn del grano con respecto a la marca del pincel
para cada marca de modo que cada marca es diferente de la anterior.

Parametros de lienzo

Textura - Establezca en qué medida la textura del lienzo debe influir en la pincelada (0-100).

= Menu de Panel de Creador de Pinceles - Guarde como Pincel Preestablecido Nuevo,
Restablezca Cambios del Pincel, Importe Pincel Preestablecido, Exporte Pincel
Preestablecido o Cierre el panel. Es posible mostrar el panel de nuevo desde el Menu de
Ventana (Window Menu).

Como crear pincel personalizado

Haga clic en una pincel preestablecido existente en el panel Propiedades, entonces haga clic

en el boton == - panel Creador de Pinceles se abrira. Si desea realizar cambios en el pincel
seleccionado, configure facilmente la forma y el grano del pincel, parametros de presion, de
forma, de grano y del lienzo del pincel personalizado - estos cambios se aplican
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automaticamente al pincel seleccionado. Cuando se realizan cambios en este pincel, nota
"Cambiado" aparecera junto al nombre del pincel.

Puede Guardar Como Pincel Preestablecido Nuevo o Restablecer Cambios de Pincel a los
valores predeterminados en cualquier momento a través del menu del panel Creador de

Pinceles.

Si desea crear un nuevo pincel preestablecido, duplique el pincel seleccionado con el botdén

@ y realice los cambios en este pincel.

Como importar pinceles personalizados
Si desea agregar el pincel preestablecido a la herramienta seleccionada, importe el pincel a
través de 'Importar Pincel Preestablecido' en el menu del panel Propiedades o en el menu
del panel Creador de Pinceles.

Como exportar pinceles personalizados
Para exportar pincel preestablecido, vaya al menu del panel Propiedades o al menu del panel

Creator de Pinceles y seleccione 'Exportar Pincel Preestablecido’. Los pinceles de Rebelle son
accesibles a través del menu "Ayuda -> Mostrar Carpeta de Biblioteca”.
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Panel de Navegador

Utilice el panel de Navegador para cambiar con rapidez
la vista de la pintura utilizando una visualizacién en
miniatura. El cuadro negro del navegador corresponde
al area visible actualmente en la ventana.

Q Reducir - Reduzca la vista de la pintura (a un
tamaiio minimo de 1%).

Q Aumentar - Aumente la vista de la pintura (a un
tamafio maximo de 2000%).

Control de Zoom - Ajuste el zoom utilizando el control
de zoom (1 - 2000%).

Q Restablecer Zoom - Compruebe el valor de zoom aqui. Pulse el botén para restablecer el
zoom al 100%.

O Encajar en Pantalla - Encaje el lienzo en la pantalla.

5 Rotar Sinistrorso - Rote la ventana gréfica sinistrorso.

@ Rotar Dextrorso - Rote la ventana grafica dextrorso.
Control de Rotacidn - Ajuste el valor de rotacidn con el control de rotacion (-180° - 180°).

& Restablecer Rotacion - Pulse el botdn para restablecer el valor de rotacién al 0°.

P4 voltear - Voltee la ventana grafica. Herramienta Voltear en panel de Navegator voltea la
ventana grafica de forma no destructiva y no transforme el imagen. El botdn estd activado
cuando la ventana grafica esta volteada.

= Mend de Panel de Navegador - Cambie a Escala de grises o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

29



Panel de Color

Elija su color del pincel en Panel de Color.

Color Actual - Ajuste el color actual.

Paleta de Color - Seleccione el color del pincel desde la
paleta de colores o introduzca pardametros numeéricos
exactos para establecer su color requerido.

Puede cambiar entre HSL y RGB modelos de color:
H - Matiz del Pincel (0-359)

S - Saturacién del Pincel (0- 55)

L - Luminancia del Pincel (0-255)

o

R - Red / Rojo (0-255)

G - Green / Verde (0-255)

B - Blue / Azul (0-255)

NOTA: RGB es un modelo de color dependiente del dispositivo - diferentes dispositivos /
monitores pueden reproducir un valor RGB determinado de manera diferente.

= Menu de Panel de Color - Cambie entre |a paleta circula y paleta cuadrada, muestre o
oclute controles deslizadores, cambie entre HSL y RGB paleta de color o seleccione cerrar
panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

SUGERENCIA: Puede ajustar atajos de teclado personalizados para aumentar / disminuir el
matiz, saturacion y luminancia desde el panel de Preferencias. También es posible ajustar la
sensibilidad del ajuste.
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Panel de Conjunto de Colores

Puede elejir su color del pincel también en Panel de
Conjunto de Colores.

Color Actual - Ajuste el color actual.

Conjunto de ultimos colores usados - Puede crear sus

colores personalizados escogiendo y haciendo clic en el

color en la paleta de colores. La ultima color utilizada se
Bl . .

EEEE BN ordenara en el primer lugar.

Conjunto de colores - Una paleta del conjunto de

Light Happy colores seleccionado. Puede agregar colores

personalizados - se guardaran para un proyecto de

TIEY
| | =
HE Nomm omon
N =

| [ |

pintura adicional aun cuando una aplicaciéon esta
cerrada.

Cream Sumimer Autumn

? Mezclar Colores - Presione el botén "Mix Colors /
Mezclar Colores" o mantenga la tecla "X" para mezclar
el color escogido con el color anterior. Se puede mezclar

colores de conjunto de color, de la paleta o del lienzo.
Ejemplo: Si quiere que su color rojo a ser mds naranja en
el tinte, haga clic en la muestra de color naranja o de pixeles de color naranja sobre lienzo - el
espectro se moverd hacia el tinte rojo-anaranjado. Cuanto mds se hace clic en el color
naranja, el tono mds naranja se pone.

2 Usar Trazado de Color - Cuando esta seleccionado, el color es recogido
automaticamente de la capa de trazado. Establezca una capa activa como una capa de
trazado de referencia desde el Menu de Panel de Capas o desde Barra de Menu -> Capa ->
Capa de Trazado (un pequeiio T en la vista previa de capa aparecerd). Esta capa es una guia
para las formas y colores a su pintura.

***" Ordenar por Matiz - Ordene colores por su valor de Matiz. Cuando desactivado, el color
ultimo afiadido se ordenara como primero.

/B - Agrega y elimina colores personalizados desde Conjunto de Colores.

Conjuntos de Colores Personalizados - Cree su propio conjunto de colores. Haga clic en el
botén para agregar el nuevo conjunto, el botén para duplicar el conjunto

seleccionado o B para eliminar conjunto seleccionado.
Puede cambiar el orden de conjuntos con arrastar y soltar o cambiar el nombre del
conjunto seleccionado haciendo doble clic.
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= Menu de Panel de Conjunto de Colores:

- Iconos Grandes - Active miniaturas grandes de muestras.

- Mostrar Nombres de Colores - Muestre nombres de colores. Puede cambiar el nombre de
color seleccionado haciendo doble clic.

- Crear Conjunto de Colores desde Archivo de Imagen - Cree un conjunto de colores del
imagen seleccionado. Se creara el conjunto nuevo con un maximo de 16 colores.

- Crear Conjunto de Colores desde Ultimos Colores Usados - Cree un conjunto de colores a
partir de los colores que uso recientemente para pintar.

- Cerrar - Cierre el panel de Conjunto de Colores. Es posible mostrar el panel de nuevo desde
el Menu de Ventana (Window Menu).

Paleta de Colores de Sistema

Después de hacer clic en un color actual en la esquina superior izquierda del Panel de Color,
una nueva ventana de Seleccionar color con una Paleta de Colores del Sistema aparece. Esta
paleta se ve y se comporta de manera diferente en Mac OS y Windows:

;9“0 Colors (@)

RiBs ==

Q |
&

Pick Screen Color

Custom colors

Add to Custom Colors

Green: 4

Blue: 121 _

Cancel =

Paleta de Colores de Sistema en Windows ~ L

(Cancel) ( OK ) |

A

Paleta de Colores de Sistema en Mac OS

Para usuarios de Windows:
Puede escoger cualquier color de la pantalla haciendo clic en un botén de "Pick Screen
Color". Al pasar por encima de su pantalla veras HSV, RGB y HTML pardmetros de un color.

El uso de la opcién 'Custom Colors" en la ventana de Paleta de colores para guardar los

colores no es necesario. Si desea guardar su color personalisado, le recomendamos que
utilice el botén "Agregar / Add" directamente en el Panel de la Paleta.
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Panel de Capas

(]
@ Mostrar Himedo - Muestre las partes hUmedas de

G |E e §5 ofs la capa actual.

Blending |Normal E]/[E Pausar Difusion - Pause la difusion. Cuando
Opacity esta pausada, el botdén esta marcado.
Lock

£2% Humedecer Capa - Humedece la capa actual.

38 Secar Capa - Seque la capa actual, el lienzo no es
himedo.

i‘fﬁ Secar Rapido - Seque la capa actual, el agua se
elimina de la pintura, pero el lienzo permanece
hiumedo.

Note: Al cambiar capas, la capa actual se seca rdpida (el
agua se seca, pero el lienzo permanece humedo) y la
capa nueva es seleccionada después.

Fusion - 23 modos de fusién: Normal, Oscurecer, Multiplicar, Subexponer Color,
Subexposicion Lineal, Aclarar, Trama, Sobreexponer Color, Sobreexposicion Lineal,
Superponer, Luz Suave, Luz Fuerte, Luz Intensa, Luz Lineal, Luz Focal, Mezcla Definida,
Diferencia, Exclusién, Restar, Tono, Saturacién, Reguladores y Luminosidad.

Opacidad - Ajuste la opacidad de la capa. (0-100).

8 Bloquear Capa - Bloquee la capa o capas seleccionadas para protegerlos de cambios no
deseados. Capa de trazado se bloqueara de forma predeterminada.

':' Bloquear Transparencia - Bloquee pixeles transparentes en la capa seleccionada.
Cuando se pinta un trazo en una capa y se bloquean pixeles transparentes en esta capa, cada
accidn se aplicard sélo en este trazo, no en los pixeles transparentes detras de él.

® Ojo - Muestra u oculta la capa activa.

Letra T en vista previa de Capa - Esta letra indica una capa de trazado. Seleccione una capa
de una Lista de capas, establezca esta capa como capa de trazado de referencia desde
Menu: Capa -> Capa de Trazado (Layer -> Tracing Layer). Esta capa es una guia para las
formas y colores a su pintura - puede ser una imagen o una foto.
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Lienzo - Elija desde texturas y colores del lienzo predeterminados.

Se puede controlar la visibilidad de la textura del lienzo utilizando el control Visibilidad de
Textura (0-100) en la ventana Seleccionar Lienzo.

Se puede controlar escalado de la textura del lienzo utilizando el control Escalado de
Textura (50-400%) en la ventana Seleccionar Lienzo.

Establezca la visibilidad de la estructura con el control deslizante Estructura de Pintura (0-
100) en la ventana Seleccionar lienzo (en el panel Capas). Vea el siguiente ejemplo:

Paint Structure

SUGERENCIA: Haga clic en el ojo @ a4l lado de un icono del lienzo para mostrar u ocultar la
textura del lienzo. Cuando se oculta, se puede guardar la pintura con el fondo transparente.

Puede encontrar mas informacidon acerca de las texturas del papel en la seccién Lienzos
Artisticos.

© Mostrar Seleccion - Muestre un area seleccionada actual en el lienzo donde se realizaran
otras operaciones. El drea inactiva fuera de la seleccién estd coloreada.

IZ' Limpiar Capa - Limpie el contenido de la capa (atajo Del).
Nueva Capa - Agrega una nueva capa.
Duplicar Capa - Duplique capa o capas activas.

—

Fusionar Capas - Fusione mdas capas en una capa. Si una sola capa esta seleccionada, se
fusionara automaticamente con la capa debajo de ella.

B Eliminar Capa - Elimine la capa o mas capas seleccionadas.
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SUGERENCIA: Arrastre la capa seleccionada arriba de cualquiera de estos botones para
ejecutar sus funciones en esa capa.

Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de
Capas.

Se puede arrastrar y soltar las capas para acomodarlos en el orden deseado.

= Mend de Panel de Capas - Seleccione una Capa de Trazado o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).
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Panel de Inclinacion

Herramienta inclinacion afecta el movimiento de pintura himeday
estd representado por un circulo con un puntero, que se puede
mover y rotar. Active / desactive la inclinacion haciendo clic en el
circulo central. Establezca la direccién y el angulo de la inclinacién del
lienzo haciendo clic en el puntero. Cuanto mas larga es la linea de la
inclinacién, el mayor es el dngulo.

Nota: La velocidad de chorreados de color depende de la inclinacion del lienzo, cantidad de

agua y color en la pintura.

— Menu de Panel de Inclinacidn

- Bloquear Inclinacién al Lienzo - Bloquee la inclinacién
para mantener su direccion cuando rota el lienzo.

- Usar Acelerémetro - Utilice el acelerémetro de la
tableta grafica para influir la inclinacion del lienzo y flujo
del color mediante la inclinacion de la tableta. Puede
ajustar la sensibilidad del acelerémetro en Preferencias -
> Herramientas (Preferences -> Tools).

- Centrar Acelerémetro - Centre el acelerémetro para
establecer un grado cero.

- Cerrar - Cierre el Panel. Es posible mostrar el panel de
nuevo desde el Menu de Ventana (Window Menu).
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Panel de Esténciles

Los esténciles son herramientas utilizadas para colocar

= un disefio, forma o linea particular en el lienzo. El
esténcil funciona como una delgada hoja de cartén o
plastico con un disefio o letras cortadas de él utilizado

Art Nouveau Amphaor

para producir el disefo de corte en la superficie de
abajo mediante la aplicacién de pintura a través de los
cortes.

Lista de esténciles - La lista de los esténciles disponibles
en Rebelle. Puede cambiar el orden arrastrando un
esténcil seleccionado a la posicion deseada. Haga doble
clic en un esténcil para cambiar su nombre.

o
& Mostrar | Ocultar Esténcil - Muestre o oculte todos

los esténciles activos en / desde el lienzo.

m Crear Esténcil desde Archivo de Imagen - Cree un
esténcil desde archivo de imagen. Después de
seleccionar el archivo, el esténcil se crea
automaticamente y se agrega al panel Esténciles.

B Eliminar Esténcil desde Biblioteca - Elimine un
esténcil seleccionado de la lista de esténciles.
= Meni de Panel de Esténciles:
- lconos Grandes - Elija miniaturas grandes de los esténciles en la Lista de esténciles.
- Crear Esténcil desde Archivo de Imagen - Cree un esténcil desde archivo de imagen.
Después de seleccionar el archivo, el esténcil se crea automaticamente y se agrega al panel
Esténciles.
- Crear Esténcil desde Capa - Cree un esténcil desde la capa actual.
- Crear Esténcil desde Seleccion - Cree un esténcil desde la seleccidn actual.
- Mantener Esténciles Activadas Quando Estan Ocultas - Los esténciles agregadas al lienzo
estardn activas incluso cuando estén ocultas.
- Eliminar Todos Esténciles desde Lienzo - Elimine todos esténciles activos desde el lienzo.
- Cerrar - Cierre el Panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana
(Window Menu).
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Como trabajar con Esténciles
Para agregar el esténcil al lienzo, elije el esténcil de la lista y haga clic en él.

Cuando el esténcil se coloca sobre lienzo, aparecera un Menu de Esténcil
en la esquina superior derecha:

Mover esténcil - Mueve el esténcil haciendo clic en el boton mover y
arrastrando sobre el lienzo. Puede seleccionar y mover el esténcil también
con el botdn derecho del raton o manteniendo la barra espaciadora +
botdn derecho del ratén (LMB). En tabletas con pantalla tactil seleccione y
mueva el esténcil con un solo toque de dedo.

Rotar esténcil - Rote el esténcil haciendo clic en el botén rotar y arrastrando sobre el
lienzo. En tabletas con pantalla tdctil, rote el esténcil con dos dedos.

Escalar esténcil - Escala el esténcil haciendo clic en el botén escalar y arrastrando sobre
el lienzo. En tabletas con pantalla tactil escala el esténcil con dos dedos.

Menu de esténcil - Seleccione para invertir, voltear horizontalmente / verticalmente,
bloquear o eliminar el esténcil:
- Invertir - Invierta el drea activa donde se puede aplicar la pintura.
- Voltear horizontalmente - Voltee el esténcil horizontalmente.
- Voltear verticalmente - Voltee el esténcil verticalmente.
- Bloquear Stencil - Bloquee el esténcil actual para evitar que se mueva, escala o acciones de
rotacion.
- Eliminar Stencil - Elimine el esténcil actual del lienzo.

SUGERENCIA: No sdlo la pintura se evita del lugar donde se coloca el esténcil, pero también el
agua y la pintura humeda toma el esténcil en cuenta. Por ejemplo, si se moja una capa donde
se coloca el esténcil, toda la capa se mojard, excepto el drea cubierta por el esténcil. Esto
funciona al revés también - si el esténcil se coloca en la capa humeda y se pulsa el botdn
"Secar Capa", todo estd seco, excepto el drea del esténcil.
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Barra de Menu

Archivo - Contiene acciones relacionadas con cargar, guardar, exportar y publicar sus
pinturas.

Editar - Contiene articulos relacionados con la edicion del proceso de pintura y el lienzo.
Capa - Contiene acciones relacionadas con las capas.

Vista - Contiene acciones relacionadas con la ventana gréfica.

Ventana - Contiene acciones relacionadas con la interfaz de usuario.

Ayuda - Contiene acciones que permiten obtener ayuda de la aplicacién o buscar
actualizaciones en la pagina web.

Menu de Archivo

El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera:

Nuevo... - Abre el cuadro de didlogo que le permite crear una nueva pintura con los nuevos
ajustes. Puede establecer la anchura vy la altura de la nueva imagen en pixels, centimetros o
inches y una DPI de la imagen; mantenga aspecto original; ajuste la textura y color del lienzo,
la visibilidad y escalado de la textura (mas sobre los papeles en la seccidn Lienzos Artisticos):

Picture Siz Picture Size Info:

Widkth:

Height: 11.00

Preseks:

Quarkter Sheet, 15.00 x 11.00 inches, 160 DPI

22.00 % 15.00 inches, 120 DPI

Full Sheek, 30.00 x 22.00 inches, 80 DPI
Double Elephant, 40.00 x 30.00 inches, 60 DPI

Emperor, 50.00 x 40.00 inches, 40 DPI

2970 x 21.00 cm, 200 DPI

70 cm, 150 DPI

2 anN inmchac 470 MDI
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También puede elegir entre variedad de ajustes de tamafio del lienzo o agregar / eliminar

ajustes preestablecidos usando los botones @/@

Después de hacer clic en un icono de Lienzo, una nueva ventana aparece con una eleccion de
lienzos artisticos preestablecidos.

Segun DPI valor que se establece, informacidn sobre el tamafio del imagen se calcula
automaticamente tanto en centimetros y pulgadas.

NOTA: Tenga en cuenta que el establecimiento de las resoluciones mds grandes para su
imagen puede retrasar su ordenador; especialmente si se utiliza una gran cantidad de agua
en la pintura.

Abrir... - Abre el cuadro de didlogo que le permite cargar una imagen desde disco en el
formato .reb, .psd, .png, .jpg, .bomp vy .tif.

Abrir Reciente - Abre una de las ultimas pinturas guardadas. Puede limpiar la lista usando la
funcién ‘Limpiar lista“.

Guardar... - Guarde su pintura. Si no ha guardado anteriormente, se le pedira que introduzca
el nombre.

Guardar Como... - Guarde una copia de su pintura actual como una nueva en formatos de
.reb, .psd, .png, .jpg, .bmp y .tif.

Guardar lterativo - Guarde versiones numeradas secuencialmente de una imagen. La

primeravez, "_1" se afiade al nombre del archivo. Posteriormente, cada vez el nUmero se
incrementa en 1y se crea un nuevo archivo numerados secuencialmente.

Importar... - Importe una imagen en formatos.png, .jpg, .bmp vy .tif como la nueva capa.

Publicar... - Publique su pintura en |la Galeria de Rebelle. Introduzca el nombre de la pintura,
opcionalmente escriba una descripcidn y etiquetas.
Preferencias de Publicar... - Un sub-menu contiene preferencias de la Galeria.

Preferencias... - Ajuste Preferencias General, Preferencias de Herramientas, de Color, de
Tableta y del Teclado. Puede encontrar mas informacién en la seccién Preferencias mas
adelante en el manual.

Quitar - Cierre la aplicacidn. (Sélo en Windows).

SUGERENCIA: También puede arrastrar y soltar (Drag & Drop) una imagen desde cualquier
aplicacion, archivo o navegador de Internet directamente a Rebelle si la aplicacion lo permite.

Para obtener mas informacién sobre como crear, cargar y guardar sus pinturas, consulte la
seccion Crear, Cargar y Guargar Pinturas mas adelante en el manual.
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Menu de Editar

Deshacer - Deshace la Ultima operacidn de pintura que ha realizado. NUmero de pasos para
deshacer depende de la memoria de su ordenador. NUmero maximo de estos pasos es 30.
Rehacer - Rehace la Ultima operacién de deshacer.

Cortar - Corte la seleccién actual o una capa seleccionada al portapapeles.
Copiar - Copie la seleccidn actual o una capa seleccionada al portapapeles.
Pegar - Pegue la seleccién actual o una capa seleccionada a la capa nueva.

Seleccionar Todo - Seleccione la capa completa.
Deseleccionar Todo - Deseleccione la seleccidn actual desde el lienzo.
Invertir Seleccion - Invierta la seleccion actual.

Menu de Capa

Nueva Capa - Agrega una nueva capa.

Duplicar Capa - Duplica capa o capas activas.
Fusionar Capas - Fusione capas en una sola capa.
Eliminar Capa - Elimine capa o capas activas.

Mostrar Capa- Muestre u oculte la capa individual.
® T image A 100 Capa de Trazado - Establezca una capa activa como una
capa de trazado de referencia (un pequeiio T en vista
previa de Capa aparecerd). Esta capa es una guia para las formas y colores a su pintura -
puede ser una imagen o foto. Puede ajustar la capa de trazado también desde el menu de

panel de capas.

Usar Trazado de Color - Cuando es seleccionado, un color es recogido automaticamente de
la capa de trazado.

Transformar Capa - Mueve y escale la capa activa.
Limpiar Capa - Limpia la capa.

Menu de Vista

Aumentar - Aumente la vista de la pintura (a tamafio maximo de 2000%).

Reducir - Reduzca la vista de la pintura (a un minimo del 1%).

Aumentar al 100% - Comprueba el valor de zoom. Pulse el botdn para restablecer el zoom al
100%.
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Encajar en Pantalla - Encaje el lienzo en la pantalla.

Ajustar al Lienzo - Establezca esta opcidn para permitir que las transformaciones se ajusten
a los bordes del lienzo.

Escala de grises - Vea el lienzo en escala de grises.
Mostrar Cursor - Muestre u oculte el cursor.

Permanecer Arriba - Aplicacién permanecera siempre en la parte superior de otras
aplicaciones.

Pantalla Completa - Cambie la ventana de la aplicacién en modo de pantalla completa.
(Presione Esc para salir).

Menu de Ventana

Herramientas - Muestre u oculte el Panel de Herramientas.
Propiedades - Muestre u oculte el Panel de Propiedades.

Color - Muestre u oculte el Panel de Color.

Conjunto de Color - Muestre u oculte el Panel de Conjunto de Color.
Inclinacidén - Muestre u oculte el Panel de Inclinacién.

Navegador - Muestre u oculte el panel de Navegador.

Capas - Muestre u oculte el Panel de Capas.

Creador de Pinceles - Muestre u oculte el Panel de Creador de Pinceles.
Esténciles - Muestre u oculte el Panel de Esténciles.

Mostrar Paneles - Muestre u oculte los Paneles para conseguir mas espacio para la pintura.
Bloquear Paneles - Bloquee la configuracién de los paneles de cualquier cambio no deseado.
Cuando estan bloqueados, no es posible desacoplar paneles, acoplar paneles flotantes o
fusionar paneles.

Restablecer a Predeterminado - Restablezca la interfaz a interfaz predeterminada.

Menu de Ayuda

Ayuda - Abra este Manual de Usuario.

Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier problema, una
idea o simplemente le gusta el programa. Puede elegir entre 3 tipos de comentarios:
Bravo - ¢ Te gustaria expresar como genial Rebelle es? Entonces...
Idea - ¢ Tiene alguna caracteristica que seria una gran adicion a Rebelle? Entonces...
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Bug - ¢Encontrd cualquier comportamiento curioso al utilizar Rebelle? Entonces...

.. introduzca su correo electrénico y mensaje - leemos cada uno. ©

Feedback type:

ofg Bravo | 3§ idea % Bug

Email:
email@email.com

Message:

Pagina web de Rebelle - Enlace a la pagina web: rebelle.escapemotions.com

Intro Tutorial - Muestra el Intro Tutorial. Este tutorial le guiara a través de las herramientas
mas esenciales en Rebelle.

Acerca de Rebelle - Obtenga un poco de informacion bdsica acerca de Rebelle, copyright y
créditos.

Idioma - Seleccione el idioma de la interfaz de usuario de Rebelle. Reinicie Rebelle para
aplicar los cambios.

Mostrar Carpeta de Biblioteca ... - Muestra carpeta donde se guardan los pinceles, datos,
documentos y lienzos.

Buscar actualizaciones... - Este botdn es visible cuando hay nuevas actualizaciones
disponibles.
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Preferencias

Rebelle le permite personalizar muchos ajustes y atajos de teclado en la ventana
Preferencias accesible desde el menu Archivo. Establezca las Preferencias General,
Preferencias de Herramientas, de Color, de la Tableta y del Teclado en Rebelle.

Preferencias General

Pantalla de Inicio - Mostrar cuadro de dialégo de "Nueva Pintura" al inicializacién de la
aplicacion - Marque esta opcidn si desea que el cuadro de didlogo “Nueva Pintura”
abre cada vez que inicie la aplicacion.

Interfaz - Ajuste la escala para cambiar el tamafio de la interfaz (70-200%).

Lienzo - Aumentar al cursor - Marque esta opcidn si desea aumentar al cursor y no al
centro del lienzo.

Opciones de Jpeg - Establezca la calidad del archivo Jpeg (0-100). Cuanto menor sea el
ajuste, menor serd la calidad del archivo .jpeg guardado.

Sensibilidad de Box de Editar - Ajuste la sensibilidad de editar del spinbox para el Ratén
o Tableta grafica (1-100) - Establezca un valor mas alto para que los cuadros (boxes)
de Rebelle sean mas sensibles a la resistencia de la pluma/el ratén.

Motor de Pinceles - Establezca CPU o GPU (experimental) motor de pinceles. Si usted tiene
una tarjeta grafica dedicada puede configurar Rebelle para ejecutar en GPU - este
motor sigue siendo inestable y puede bloquearse inesperadamente, porque es por
ahora sdlo experimental.

Memoria - Establezca la memoria maxima que Rebelle puede usar.

Idioma - Seleccione el idioma de la interfaz de usuario. Seleccione si los idiomas se deben
actualizar automaticamente o no.

Preferencias de Herramientas

Pinceles - Seleccionar el ultimo pincel usado cuando el color es escogido de la paleta -
Habilite esta opcidn si desea que el Ultimo pincel usado para ser seleccionado de
forma automatica después de escoger un color del Panel de Color.

- Mostrar capa humeda cuando se ulitiza herramienta Mojar o Secar - Habilite esta
opcion si desea que herramientas Mojar y Secar activan el modo Mostrar Himedo.

Lazy Mouse - Ajuste la fuerza del Lazy Mouse (0-10). El mayor es nimero de control de Lazy
Mouse, las lineas mas suaves se pueden pintar.

Acelerémetro - Ajuste la sensibilidad del acelerémetro (1-10). Cuanto mayor sea el nUmero
gue establezca, mas sensible serd la inclinacion al utilizar la inclinacidén de la tableta,
lo que resulta en un flujo de acuarela mas rapido.
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Redimensionar Pincel - Establezca el color personalizado del cursor del pincel en el modo de
cambio de tamafio.

Transformacidn - Establezca el angulo de bloqueo personalizado para transformar cuando se
usa Shift con rotacion.

Preferencias de Color

Tamaio de Muestra de Color de Trazado - Elija el tamafio promedio de la muestra de
trazado de color (1 pixel, 3x3 pixeles, 5x5 pixeles).

Mezcla de Color - Ajuste la sensibilidad de Mezcla de Color (1-100). La sensibilidad influye el
numero de pasos entre dos colores mezclados. Cuando la sensibilidad es baja, se
requieren menos pasos (clics) para alcanzar el segundo color de la mezcla. Cuando
la sensibilidad es alta, se necesita mas clics para alcanzar el segundo color
mezclado.

Ajustar Color con Atajo del Teclado - Ajuste la sensibilidad de atajos para ajustar colores (1-
10). La sensibilidad influye la distancia entre dos colores. Cuando la sensibilidad es
alta, la distancia entre dos colores en la paleta de colores serd menor.

Mostrar Himedo - Establezca el color de la vista previa de areas hiumedas en el modo
‘Mostrar Himedo’.

Esténciles - Establezca el color personalizado de los esténciles y su opacidad (1-100).

Preferencias de Tableta

Opciones de Tableta - Seleccione Usar el posicién del ratén o stylus y dispositivo Wacom
(WinTab) o Microsoft Ink. Reinicié de Rebelle es necesario para aplicar los cambios.
- Habilitar multi-toque - Activar / desactivar gestos multitouch en Rebelle - Cuando
estd deshabilitado, no podra utilizar el toque de dedo para mover, escalar o rotar
funciones en el lienzo.

- Sensibilidad de Touchpad - Ajuste la sensibilidad para touchpads y trackpads (1-
100%) - cuando se establece en valores mas altos, la sensibilidad de la accién de
'mover' con el toque en trackpads sera mas significativa.

Sensibilidad de Presion de Stylus - Ajuste la sensibilidad de presién de stylus. Cuando se
establece en ‘Suave’ se requiere menos presion, cuando se establece en ‘Firme’ se
requiere mas presion.

Preferencias de Teclado

Establezca los atajos de teclado personalizados. Haga clic en Restablecer para restablecer el

atajo actual o Eliminar para eliminar el atajo seleccionado. Haga clic en Restablecer Todos

para restablecer todos los atajos a los atajos predeterminados.

Haga clic en OK para confirmar los cambios realizados en Preferencias o Cancelar, si no lo
desea.
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Empezar a Pintar

Opciones de Flujo de Trabajo

Empezar una nueva pintura con el lienzo en blanco

1. Haga clic en Archivo -> Nuevo... y una nueva ventana aparecera.

2. Establezca una anchura, una altura de la imagen, la textura del papel y DPI de imagen.

3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafo del pincel y otros parametros en el Panel de
Propiedades y empiece a pintar.

Empezar con una foto o una imagen de referencia

1. Haga clic en Archivo -> Abrir... y elija su imagen de referencia.

2. Haga clic en Agregar Capa en Panel de Capas para crear una nueva capa en la parte

superior de la capa de referencia.

3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafo del pincel y otros parametros en el Panel de
Propiedades y empiece a pintar.

Puede importar un dibujo previamente escaneada o dibujado en un software tercero en
formato .png, .jpg, .bmp y .tif haciendo clic en Menu -> Archivo -> Importar... (File ->
Import...).

También puede arrastrar y soltar una imagen desde cualquier aplicacidon o navegador de
Internet directamente a Rebelle como una nueva capa.

Trabajar con Agua

Al pintar con un medio humedo (acuarela, acrilico y pluma) se puede establecer la cantidad
de agua. Con mas agua, el color se extendera mas rapido sobre la capa y colores humedos se
mezclan.

No solamente los colores pueden ser himedos, con un botén 'Humedecer Capa' £2* (en
’Panel de Capas’) se puede humedecer la capa completa. Cémo la pintura se mezcla y se seca
depende del agua y la humedad del papel por debajo de ella.

Para ver si o donde una pintura esta humeda, haga clic en el botén ‘Mostrar Haimedo’ @.
Un color azul claro muestra la humedad del lienzo y del color - la mayor cantidad de agua se
aplica, el mas oscuro el color azul se mostrara.
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Color Layer/Capa de Show Wet/Mostrar Fast Dry/Secar Rapido  Wet the Dry the
Color Humedo Layer/Humedecer Capa Layer/Secar Capa

Para acelerar su proceso de pintura hemos implementado 2 funciones:

Boton 'Secar Capa’ 3 seca completamente la capa activa con todo su contenido — la
pintura, el lienzo y agua aplicada.

Puede utilizar un botén de 'Secar Rapido' f-‘.fri cuando quiere agua para ser removido de su
capa activa pero desea mantener la humedad del lienzo.

SUGERENCIA: Pause la simulacion de fluidos en cualquier momento durante la pintura

haciendo clic en el botén Pausar Difusion en Panel de Capas: @ / @

Se pueden utilizar diferentes técnicas de pintura para obtener diversos efectos. En la
siguiente imagen puede ver cdmo diferentes combinaciones interactian entre si. El mas
himedo el papel y el color, el mas difunde el color. Sin embargo, las herramientas secas
(pastel, lapiz, rotulador y aerégrafo) no se difunden en la pintura menos humeda; se
difunden de acuerdo a humedad de su pintura.

Dry on Dry Wet on Dry Wet on Wet Paper

W 5\
~ 5 S

Si desea obtener mas informacién sobre la técnica adecuada acuarela, recomendamos ver
nuestros tutoriales en YouTube.
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Opcion de Trazar una Imagen

Rebelle le permite crear pinturas trazando los colores de una imagen seleccionada. Puede
arrastrar y soltar imagenes directamente desde cualquier aplicacién o navegador de Internet
directamente a Rebelle como una nueva capa. El uso de la opciéon de trazar le permite
recrear imagenes existentes en su propia manera.

Cuando se utiliza el trazado de color, el color se aplica para cada trazo. Esto significa que
cada trazo de pincelada recoge el pigmento de color desde el primer "clic" y lo utiliza hasta
qgue hace el otro clic.

Rebelle no traza todos los colores de |la capa de trazado durante un solo trazo.

Como trazar una imagen existente o importada:

1. Haga clic en Menu -> Archivo -> Importar... para abrir el cuadro de didlogo de Import.
Una imagen se importa como una nueva capa. También puede arrastrar y soltar
imagenes directamente desde cualquier aplicacidon o navegador de Internet.

2. Seleccione esta capay haga clic en Menu -> Capa -> Capa de Trazado. Una capa se
establece como una capa de trazado de referencia (un pequefio T en la capa de vista
previa aparecerd). Esta capa es una guia para las formas y colores a su pintura.

3. Agregue una nueva capa Yy haga clic en Menu -> Capa -> Usar Trazado de Color o haga
clicen el botén " Usar Trazado de Color" desde Panel de Conjunto de Colores.

4. Ahora ya esta listo para trazar los colores de su imagen de referencia en una capa

activa.

Si Trazado de Color no es seleccionado usted puede pintar con otros colores. Deseleccione
Capa de Trazado desde Menu -> Capa -> Capa de Trazado.

Capa de Trazado estd bloqueado por defecto para protegerla de cambios no deseados.
Puede desbloquear la capa haciendo clic en el botdn de "bloqueo".

Trabajar con Selecciones

En Rebelle se puede seleccionar facilmente el drea del lienzo para realizar operaciones
especificas sélo dentro de este area seleccionada. Las selecciones sirven como herramientas
de enmascaramiento que bloquean las areas del lienzo que no desea cambiar.

Las operaciones que se pueden realizar en la seleccion en Rebelle incluyen pintar,
transformar, cortar, copiar y pegar. También es posible crear el esténciles de la seleccion.

Cuando una seleccion esta activa, se dibuja en el lienzo con guiones. Todo lo que esta dentro
del area delimitada estd seleccionado, todo lo que estd fuera no esta seleccionado.
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Pintar dentro de seleccion

Cree una mascara simple en el lienzo utilizando la herramienta de seleccion. Elija entre la
seleccion rectangular, eliptica, poligonal o a mano alzada y cree la seleccidn en el lienzo.
Usted pintara dentro de la seleccidn, el area exterior permanecerd intacta. Para pintar en las

areas fuera de la seleccidn, haga clic en el botdn "Invertir selecciéon” l:] en el panel
Propiedades de la Seleccion.

Nota: Puede ver rdpidamente su seleccion actual mediante el boton Mostrar Seleccion © en
el panel Capas. El drea no activa en el lienzo es de color rojo.

Transformar seleccion

Seleccione las partes especificas de su pintura usando la herramienta de seleccion. Para
transformar esta seleccién, haga clic en Transformar en el panel Herramientas o el atajo Ctrl
+T/Cmd + T. Puede mover, escalar, rotar o voltear la seleccion horizontal o verticalmente.
Se puede encontrar mas informacién sobre transformacién en la seccidon Propiedades de
Herramienta Transformar.

Nota: Cuando se selecciona y transforma una parte de la pintura en la capa, la confirmacion
de la transformacion colocard el drea transformada en una nueva capa.

Cuando se selecciona y transforma toda la pintura en la capa, permanecerd en la misma
capa.

Cortar, Copiar y Pegar Seleccidn

Puede realizar funciones simples de cortar, copiar y pegar en el area seleccionada del lienzo
mediante el menu Editar o con los atajos de teclado.

Use Ctrl + X/ Cmd + X para cortar la seleccion y Ctrl + V/Cmd + V para pegar la seleccion.
Puede cortar y pegar también desde el menu Editar. Su seleccidon se pegara a una capa
separada.

Use Ctrl + C/ Cmd + C para copiar la seleccidn y Ctrl + V / Cmd + V para pegar la seleccion.
También puede copiar y pegar desde el menu Editar. Su seleccién se pegard a una capa
separada.
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Seleccionar Todo / Deseleccionar Todo

Seleccione el contenido de la capa actual con atajo Ctrl / Cmd + A o mediante el menu
Editar -> Seleccionar todo.

Deseleccione la seleccion actual con atajo Ctrl / Cmd + D atajo o mediante el menu
Editar -> Deseleccionar todo.

Se puede cambiar estos atajos en cualquier momento a través del panel Preferencias ->
Teclado -> Editar.

Invertir seleccion

Invierte la seleccion actual. El drea seleccionada se desactivara. Invierte seleccidon usando
Ctrl / Cmd + Shift + | atajo o mediante el menu Editar -> Invertir seleccion.

Se puede cambiar el atajos en cualquier momento a través del panel Preferencias -> Teclado
-> Editar.

Crear esténcil de seleccion

En Rebelle puede crear un esténcil de su seleccidn a través del Menu del Panel de esténciles.
Dibuje su seleccion en el lienzo y confirme la seleccién, después vaya al Menu del panel de
los esténciles y haga clic en "Crear Esténcil a partir de Seleccion". El nuevo esténcil se creara
automaticamente y se agregara al panel de esténciles.

Soporte Multitactil

El soporte multitactil estd disponible tanto para Windows y Mac O y ofrece un mayor apoyo
para las tabletas con pantallas tactiles y multitactiles. Puede desplazar, rotar y hacer zoom la
ventana grafica o la capa individual. Esto pofrece una forma sencilla y sensible de
posicionamiento y navegacion por el lienzo.

Use dos dedos para rotar y mover el lienzo al mismo tiempo,
moviéndolos en un movimiento circular mientras lo pasa
simultaneamete a través de la tableta. Al mismo tiempo se puede
zoom la ventana grafica apretando los dedos juntos o separandolos.
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Use un dedo para la herramienta Fusionar de forma predeterminada.
Puede configurarlo para cualquier otra herramienta (o para mover el
lienzo) en el panel de Preferencias -> Teclado -> Herramientas
(mantener) y configurarlo para ‘Toque’.

Lienzos Artisticos

Hay varias texturas y colores del lienzo predeterminadas para elegir en la ventana
‘Seleccionar Lienzo’:

m/El - Importe o elimine la textura del lienzo a / desde ventana ‘Textura del Lienzo’.

/B - Agrega o elimine el color del lienzo a / desde ventana ‘Color del Lienzo’.

Se puede controlar la visibilidad de |a textura del papel utilizando el control de Visibilidad de
Textura.

Se puede escalar la textura utilizando el control de control de Escalado de Textura.

Se puede controlar la estructura de la pintura con el control de Estructura de Pintura.

Por favor, tenga en cuenta que la textura del lienzo afecta la forma en que los pinceles y
herramientas se comportan al pintar, mezclar, borrar o usar cualquier herramienta
disponible.

Por ultimo, haga clic en OK para confirmar, o Cancelar, si no lo desea.

Nota: Texturas del lienzo son accesibles a través del Menu: Ayuda -> Mostrar Carpeta de
Biblioteca... (Help -> Show Library Folder), donde se puede pegar cualquier textura del lienzo
enlosable a la carpeta del "Papers". Reinicie una aplicacion para recargar nuevos papeles.
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Crear, Cargar y Guargar Pinturas

Crear Nueva Pintura

Para crear una nueva pintura, seleccione la opcidon Nuevo... en el Menu de Archivo. Al hacer
esto, ventana de Nueva Pintura aparecerd. Esta ventana le permite ajustar el tamafio de la
nueva pintura y configurar los ajustes del lienzo. En seccion "Informacién sobre Tamafo de
Imagen” puede comprobar el tamafo de impresion de la imagen tales como anchura, altura
y DPI.

Al hacer clic en el Icono del Lienzo se puede seleccionar el color y la textura del lienzo,
visibilidad y escalado de la textura

Por ultimo, haga clic en OK para crear una nueva pintura, o Cancelar, si no lo desea.

Abrir Pintura

Para abrir una pintura, seleccione la opcién Abrir... en el Menu de Archivo. Este panel le
permite abrir una imagen o ilustracion previamente guardada en el formato de archivo .reb,
.psd, .png, .jpg, .bomp y .tif como un nuevo projecto.

Por ultimo, haga clic en OK para abrir la pintura, o Cancelar, si no lo desea.

Para abrir una pintura recientemente guardada, seleccione la opcion Abrir Reciente en el
Menu de Archivo. Esta opcion le permite seleccionar una de las ultimas pinturas guardadas
en .reb, .psd, .png, .jpg, .bmp vy .tif formatos de archivo.

Guardar Pintura

Para guardar la pintura, utilice la opcidn Guardar... en el Menu de Archivo. El formato nativo
es formato de archivo REB, que contiene toda la informacién acerca de la pintura y las
capas. Utilice este formato si desea continuar con la pintura mas tarde. Le recomendamos
que guarde su trabajo periédicamente para evitar cualquier problema, mientras que
acostumbrarse a un nuevo software.

Si desea guardar la pintura con los ajustes especificas o en forma que puede ser leida por
otras aplicaciones, utilice la opcion Guardar Como... del Menu de Archivo. Le permite
guardar la pintura en el formato PSD, PNG, TIF, BMP o JPG. No es necesario fusionar capas
para crear una copia de su pintura para la impresién o para mostrar en la web. Las capas
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individuales se guardan en formato de archivo REB y PSD.

Nota: Por favor, tenga en cuenta que solo el archivo REB contiene toda la informacion de
imagen. Archivos PSD, PNG, TIF y BMP guardan solamente la informacion sobre el color y la
transparencia. La transparencia no se guarda en el formato JPG.

Por ultimo, haga clic en OK para guardar la pintura o Cancelar si no lo desea.

Guardar lterativo - Guarde versiones numeradas secuencialmente de una imagen. La
primeravez, "_1" se afiade al nombre del archivo. Posteriormente, cada vez el nimero se
incrementa en 1y se crea un nuevo archivo numerados secuencialmente.

Cerrar Aplicacion

Si desea cerrar una aplicacién, se puede elegir entre las siguientes opciones dependiendo de
su sistema operativo:

Usuario de Windows Usuario de Mac OS
- haga click en Archivo -> Quitar, o - haga click en Archivo -> Quitar, o
- presione un botdn Cerrar en la esquina - presione un botén Quitar en la esquina
superior derecha de una aplicacién o superior derecha de una aplicacién o
- utilice el atajo Ctrl+W o Alt+F4 - utilice el atajo Cmd+Q

Nota: Por favor no se olvide de guardar su pintura antes de cerrar una aplicacion.

53



Publicar una Pintura a Galeria

Crear una Cuenta de Galeria

Para publicar sus pinturas, en primer lugar hay que crear una cuenta. Para crear una cuenta,
tiene dos opciones:

De aplicacion:

Crea tu Cuenta de Galeria desde el Menu de Rebelle: Archivo -> Preferencias de Publicar.
Elija Su Nombre, Correo Electrénico ("Su ID") y la Contrasefia para la galeria y, opcionalmente
el enlace a su Pdgina Web.

De web:

En Pagina web de la Galeria haga click Inicio de sesion -> Crear cuenta (login -> Create
Account) e introduzca "Su ID" (correo electrénico de su registracion).

Le enviaremos una Contrasefia, que se puede cambiar mas adelante.

Nota: Puede encontrar "Su ID" en el menu de Rebelle Ayuda -> Acerca de Rebelle.
Si "Tu ID" no existe, introduzca su direccion de correo electronico activo.

Publicar Pinturas de Rebelle a Galeria

Para publicar su pintura, utilice la opcion Publicar... en el Menu de Archivo. Introduzca el
Nombre de la Pintura, un Descripcion y Etiquetas de Pintura. Haga clic en el botdn Publicar.
Tu pintura serd publicada en la pagina web de la Galeria (www.escapemotions.com/gallery),

donde puede editar las imagenes mas tarde.

Editar tu Perfil y Pinturas en Galeria

Si ya ha creado una cuenta, vaya al sitio web de Gallery, pulse Login / Iniciar session
eintroduzca"Su ID" y la Contrasefia / Password.

En la seccion Edit Pictures / Editar imagenes se puede editar el nombre de las pinturas,
descripcidn, etiquetas y otros ajustes.

En la seccién My profile / Mi perfil puede cambiar su Contrasefia.
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Atajos de Teclado

Windows
New... / Nuevo... Ctrl+N
Open... / Abrir... Ctrl+O
Save / Guardar Ctrl+S
Save As... / Guardar Como... Ctrl+Shift+S
Iterative Save / Guardar Iterativo Ctrl+Alt+S
Import.../ Importar... Ctrl+Shift+O
Preferences / Preferencias Ctrl+,
Quit / Quitar Ctrl+W
Undo / Deshacer Ctrl+Z
Redo / Rehacer Ctrl+Shift+Z
Cut / Cortar Ctrl+X
Copy / Copiar Ctrl+C
Paste / Pegar Ctrl+Vv
Select All / Seleccionar Todo Ctrl+A
Deselect All / Deseleccionar Todo Ctrl+D
Invert Selecion / Invertir Seleccion Ctrl+Shift+l
Brushes / Pinceles B
Eraser / Borrador E
Blend / Fusién N
Smudge / Manchar S
Water /Agua w
Dry / Secar D
Blow / Soplar Shifto O
Pick a color / Escoger el Color Altoll
Transform Layer / Transformar la Capa To Ctrl-T
Selection / Seleccién M
Lock proportions at scale /
Bloquear propociones a escala Shift
Scale around center /
Escalar alrededor del centro Alt
Lock rotation at 45 degrees /
Bloquear rotacién a 45 grados Shift
Mix / Mezclar X
Show Wet / Mostrar Himedo H
Fast Dry / Secar Rapido F
Paint / Pintar B

Increase Brush Size /

Mac OS

Cmd+N
Cmd+0O
Cmd+S
Cmd+Shift+S
Cmd+Alt+S
Cmd+Shift+O
Cmd+,
Cmd+Q

Cmd+Z
Cmd+Shift+Z
Cmd+X
Cmd+C
Cmd+V
Cmd+A
Cmd+D
Cmd+Shift+l

B

E

N

S

w

D
Shifto O
Altol
ToCmd-T
M

Shift

Alt

Shift
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Aumentar el Tamano del Pincel
Decrease Brush Size /
Disminuir el Tamano del Pincel
Resize Brush on Canvas /
Redimensionar Pincel en Lienzo

Move Layers Up /

Mover Capas hacia Arriba
Move Layers Down /

Mover Capas hacia Abajo
Select Prev Layer /

Seleccionar Capa Anterior
Select Next Layer /

Seleccionar Capa Siguente
Clear Layer Content /

Limpiar el Contenido de la Capa

Increase Value +1 / Aumentar el Valor +1
Decrease Value -1 / Disminuir el Valor -1

Ctrl

Ctrl + [
Ctrl +]
Alt + [
Alt +]
Del

Up
Down

Increase Value +10 / Aumentar el Valor +10 Pg Up
Decrease Value -10 / Disminuirel Valor -10 Pg Down

Rotate Canvas / Rotar Lienzo
Move a Canvas / Mover Lienzo

Select Stencil / Seleccionar Esténcil
Remove Stencil / Eliminar Esténcil

Show | Hide All Panels
Zoom In / Aumentar

Zoom Out / Reducir

Zoom 100% / Acercar 100%

Fit to Screen / Encajar en Pantalla

Greyscale / Escala de Grises

Zoom In | Out / Aumentar | Reducir

Help / Ayuda

R

Cmd

Cmd + [
Cmd +]
Alt + [
Alt +]
Del

Up
Down
Pg Up

Pg Down

R

Boton derecho del ratén o Escpaciador + LMB

Right MouseButton (RMB) or Space Bar + LMB

Backspace

Tab
+/Ctrl + +
-/Ctrl + -
0/Ctrl +0

G

Backspace

Tab
+/Cmd + +
-/Cmd + -
0/Cmd +0

G

Desplazamiento o Desplazamiento + Alt

F1

F1

Nota: Puede crear ajustes personalisados para esas y otras funciones desde el Menu:

Preferencias -> Teclado (Preferences -> Keyboard).
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especialmente a Jay Hardy, Jason Maranto, Carlos Ferreira, Predrag Kalajdzijevic, Spencer
Jarvis, Tim Shelbourne, Axel Cardeneo, Rana Dias, Matus Fedorko, Daniel Innes, Tomas
Lancz, Michelle Parsley, Rastislav Piovarci, Lubomir Zabadal, Daniel Murray, Kamila
Stankiewicz, Martin Haschild, Will von Dehl, Matthew Cox, Alexander Miroshnikoff and
Whitney Pollet.

Traducciones por: Tanya Hayman, Tony Lloyd, Daniel Streidt, Higashiuchi Takuri, Kenjiro
Nagano, Marta Fernandez, Irene Briz, Elke Schnabel, Pat McDonald, Sergey Krotov, Maciej
Dobrenko, Tatjana Prelog, Kouki Aikawa, Davi Goldberg, Massimo Corinaldesi, Anna Aroui,
Burak Erdogan, Roni Kantola, Umin Kang, Deo.R, Andy Chen, Andrea Hornakova, Veronika
Klimekova.

Esténciles y papeles creados por Lubomir Zabadal.

Iconos de la Interfaz de Usuario originales "Batch" por Adam Whitcroft.

Bibliotecas usadas:
Esta aplicacion ha sido desarrollada con las siguientes bibliotecas:

Qt, LGPL license - http://qt-project.org/downloads/
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Rebelle End-User Software License Agreement

Copyright 2015-2017 Escape Motions, s.r.o. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Rebelle
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use

Users of the Rebelle may use the Software for commercial, or for-profit activities as well as
for personal, non-commercial, or non-profit activities.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

You may install the Software on multiple computers provided that not more than one of
those computers is in use simultaneously and that those computers are solely for your own
personal use.

You may not remove the copyrights notices from the Software. You may make one (1) copy
of the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.

¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on
the Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web
server, ftp server, file sharing network, shared directory, or other location where any other
person can acquire a copy of the Software. You are responsible for keeping the Software
safe from being copied by others.
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Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions
or suits, as well as any related expenses, liabilities, damages, settlements or fees arising from
your use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE
FOR CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION
WITH THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.

59



